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Welcome to your
new Audient iD14
Audio Interface

To help get you started please visit

to download the latest software

and firmware.

Inside the box:

« D14
« USB-C to USB-C cable
e« Quick Start Guide

Features include:

2 x Audient Console Mic Pre’s
Class Leading Converters

1 x JFET Instrument Input

4 x Line Outputs

Dual Headphone Outputs
ADAT Input for Expandability
Ultra Low Latency Software Mixer
Advanced Monitor Control
Scrollcontrol

True Phantom Power over USB
USB3.0 Bus Powered

All Metal Design

Free Software + Plugins
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iD14 Overview
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Safety Information

Important Safety Instructions

Please read all of these instructions and save them for later reference before connecting
the USB and powering up iD14.

The iD14 itself does not operate with any high voltage mains supply inside the unit but appropriate
safety measures should still be adhered to regarding the USB supply.

audient.com/support

Consult a qualified technician if you suspect difficulties. Do not attempt to tamper with the
power supply or mains voltages - HAZARDOUS TO HEALTH. Ensure that the appropriate

international pin adapter is fitted to the power supply before insertion into the mains socket.

...............................................................

WARNING!

To reduce risk of fire or electrical shock,
DO NOT expose this apparatus to rain

or moisture.
No user serviceable parts inside.

Please refer servicing to qualified

service personnel.

...............................................................



Safety Information

Important Safety Instructions
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Read these instructions

Keep these instructions

Heed all warnings

Follow all instructions

Do not use this equipment near water

Clean only with dry cloth

Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment
(including amplifiers) that produce heat

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized

plug has two blades with one wider than the other. A grounding type plug has two blades
and a third grounding prong. The wide blade or the third prong are provided for your safety.
If the provided plug does nof fit into your outlet, consult an electrician for replacement of the
obsolete outlet

Protect power cords from being walked on or pinched particularly at plugs, convenience
receptacles, and the point where they exit from the equipment

Only use attachments/accessories specified by the manufacturer

Unplug this equipment during lightning storms or when unused for long periods of time

Refer all servicing to qualified service personnel. Servicing is required when the equipment
has been damaged in any way, such as power supply cord or plug is damaged, liquid has
been spilled or objects have fallen into the equipment, the equipment has been exposed to
rain or moisture, does not operate normally, or has been dropped

For products that are a mains powered device: The equipment shall not be exposed to dripping

or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment

Declaration of Conformities

FCC Part 15B

This apparatus has been tested and found to comply with the limits of a class-A digital device,
pursuant to Part 15B of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment

off and on, the user is encouraged to try to correct the interference by one or more of the following

measures:
1. Re-orient or relocate the receiving antenna
2. Increase the separation between the equipment and receiver
3. Connect the equipment into an outlet on a different circuit from that
to which the receiver is connected
4. Consult the dealer or an experienced radio/TV technician for help
We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK,
C 01256 381944, declare under our sole responsibility that the product iD14
complies with Part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference,
2. This device must accept any interference received,
including interference that may cause undesired operation
We, Audient Ltd, declare that the product, the iD14, to which this declaration
€ relates, is in material conformity with the appropriate CE standards and
directives for an audio product designed for consumer use.
Audient Ltd has conformed where applicable, to the European Union's
Directive 2002/95/EC on Restrictions of Hazardous Substances (RoHS) as

2002/95/EC

well as the following sections of California law which refer to RoHS, namely
sections 25214.10, 25214.10.2, and 58012, Health and Safety Code; Section
42475.2, Public Resources



Installation

Mac Installation

System Requirements

macOS 10.11.6 (El Capitan) or later
Mac: Intel or Apple Silicon CPU,
1GB RAM Minimum

1. Download the latest iD
Software

Head to our website for the latest version of

our iD Mixer:

audient.com/products/downloads/
iD14

Drag the downloaded app into your

application folder to install it.
2. Connect iD14

Using the USB cable provided, connect
iD14 to your computer’s USB port.




Mac Installation

3. Status LED

Once connected to your computer and
powered on, the white USB LED on iD14 will

illuminate.

If at any time the status LED turns off during
normal operation please check all connections
and if further problems develop please

contact Audient support.

4. Double Checking Connectivity
To ensure iD14 has been detected by your
computer and correct clocking sources are

sef-up, navigate to:

Macintosh HD > Applications >

System Preferences

Check that iD14 is set as your i/o device.

It's recommended to disable system sounds.

eon Sound
[0 ] [ showail | (a
{ Sound ffects [IETTIM Inout |
Select a device for sound output:
Hame Type
Intermal Speakers Built-in
Awid CoreAudio Davice
Pro Tools Aggregate 1/0 Aggregate deviee
Audient iD14 UsE

Setings for the selected device:

The selected device has no output controls

Output volume: *;}) Mute

¥ Show velume in menu bar

5. Open the iD Mixer

Run the iD software. It will appear as an icon
in the Menu bar of MacOS. Click on this and

select “Open Mixer Software”.

Show Mixer

About iD
Visit iD Knowledge Base
Register Product

Check for Updates

Set Clock Source

Quit

Windows Installation

Windows System Requirements:

« Windows 7 or later (32 or 64 bit)
e Intel Core 2 @ 1.6 GHz, or AMD

equivalent
e« 1GB RAM Minimum

1. Download the iD14 Software

Head to our website for the latest version of

our iD Windows Installer:

audient.com/products/downloads/
iD14

2. Connect iD14

Using the USB cable provided, connect
iD14 to your computer’s USB port.

3. Run iD Mixer Setup

Double click on the installer to run the iD mixer

sefup and follow the onscreen instructions.

4. Reboot PC

Reboot your PC to make sure that all the

drivers have been applied.

1

‘gsmm

Welcome to the Audient USB Audio
Driver v4.0.3 Setup Wizard

This wizard will guide you through the installation
of Audient USE Audio Driver v4.0.3,

It is recommended that you close all other
applications before starting Setup. This will make
it possible to update relecant system files withoul
having to reboot your compler.

Click Neot 1o continue.
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Windows Installation

4. Check Connectivity

The USB status LED will illuminate as soon as
iD14 has achieved stable communication and
should remain solidly lit during operation of

the unit until power down.

To double check the connection, go to PC

sound settings by following:

PC Settings > Control Panel > Hardware and

Sound > Sound

Here you can see whether iD14 is visible to
the PC and you can make it the computers

default sound device by pressing ‘Set Default’.

iD Icon

Once installed, the iD icon can be found in the
Windows system tray (it may be in the hidden

icons area):

« Double-click to open iD14 mixer window
when iD14 is connected
« Right-click to quit or change sample rate

and buffer size.
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Formixing, buffer size of 256 should be perfect.
For tracking, experiment with lower buffer
size values. How powerful your computer is,
and how processor hungry your project is,
will affect how low you can get the buffer size

seftings before you get audio instability.

Mixer App & Firmware Update

Launch the iD Mixer Application

Launch the iD14 mixer application

by finding it in the following folder:

Macintosh HD > Applications > iD
Start > All Programs > Audient > iD

For more information on the mixer

application feature set, please refer to

page 21 of this manual onwards.

AUDIENT

Check for Firmware Updates

If your computer is connected to the internet,
the iD app will check for firmware updates
whenever a unit is connected. If there is @
firmware update available then the iD app

will notify you.

You can manually check for updates by
going to the Help menu and selecting ‘Check
for Updates’. It will notify you if you're on the

latest version of firmware.
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Firmware Update

When there is a firmware update, you can
select ‘From audient.com’ to download the
latest version automatically (or select ‘From

file’ to install a local firmware file).

UPDATE FIRMWARE

From audient.com:

13

® From file:

The latest version number will be retrieved
from our servers and will be displayed (as
shown above). Press next to continue with the
firmware update. Press ‘update’ to

install it.

Update Firmware

UPDATE FIRMWARE




Hardware Features

Microphone Preamplifiers
& Line Inputs

iD14 features two classic Audient Console
microphone preamplifiers. These preamps
are based on designs from Audient’s classic
consoles and are the same that are used

across our entire ‘iD interface range’.

The design features discrete Class-A circuitry
providing exceedingly low distortion and
noise performance. From a sonic point of

view, iD14 is fast, open and detailed.

Amphenol™ XLR/TRS Jack combi-connectors
provide microphone and line inputs. The line
inputs are padded through the microphone

preamplfiiers.

AUDIENT

0 GAIN 10

1

The microphone preamplifiers feature:

58 dB of clean gain

48v (+4V) phantom power rated at

10mA/channel

> 2.8kQ input impedance which

provides a punchy tone from any

microphone transducer type
Extra features such as a +10dB boost
and polarity reverse can be accessed

via the iD App (See page 23).

2 MIC/LINE 1




Instrument Input

iD14 employs a discrete class-a JFET
instrument (D.I) input on channel one which is

easily accessible on the front of the unit.

The JFET circuitry adds a tiny bit of colour and
distortion to the signal, making it sound great

on guitars and basses.

Plugging in a TS (tip-sleeve unbalanced)

jack will override the mic signal and turn
channel one into a fully fledged, fantastic
sounding instrument input with access to the
polarity reverse (useful for phase alignment
between a mic and D.l) and the +10dB boost

for quiet inputs.
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Headphone Output

iD14 features an independent high-current
headphone amplifier. This can be accessed
using both the 3.5mm and 6.35mm sockets
found on the front of the unit. The same
audio signal comes out of both connectors
simultaneously, so it does not matter which
you plug your headphones into. You can also

plug in two pairs at the same time.

The headphone output can comfortably drive
a wide range of headphone impedances
meaning that you will get great sounding
audio no matter what model of headphones

you have.

Digital Inputs

iD14 features an opfical input connection.
This can be set to operate as stereo optical
S/PDIF or 8-channel ADAT (SMUX) via the
System Panel in the iD mixer application. Both
formats will operate at up to 96kHz sample

rate.

OPTICAL
INPUT

Running in S/PDIF mode allows 2 channels of
audio up to 96KHz.

Running in ADAT mode, the optical input

provides a great way to expand to 10 inputs
forrecording via an external mic preamp such
as an Audient ASP800. When using 88.2kHz
and 96kHz as a sample rate, you only have
access to 4 channels of digital input (due to

the way ADAT works at higher sample rates).

For more information about system clocking

please refer to pages 28 onwards.
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Speaker Outputs

iD14 has two pairs of stereo speaker oufputs
on the back panel in the form of balanced TRS
jack connectors. The outputs are impedance
balanced using the same topology as our
flagship console, the ASP8024.

The outputs are fed from high quality DACs
(Digital to Analogue Convertors) sending
clean, linear audio to your speakers, perfect

for critical listening.

AUDIENT

4R OUT 3L

You can use these outputs for more than just
speakers. A good example of this is if you
want to use a dedicated headphone amplifier
for multiple musicians, you can connect this
up to one or more of these outputs, This is

configured in the iD mixer software.



Monitor Control

iD14  provides excellent monitor control

functionality using the large aluminium
encoder and the encoder buttons.
As such, it is possible to control main
loudspeaker and headphone volumes with a
perfectly matched stereo volume control

on the main unit.

The three encoder mode buttons allow you
to change what the encoder controls. The

button that is selected will be illuminated.

Loudspeaker and Headphone
Buttons

Pressing the speaker or headphone button
allows the encoder to control the level of the
selected output. The volume of the output is
displayed on the meter LEDs and a press of

the encoder will mute the output.

When a selected output is muted, the
corresponding encoder button will flash,

repeatedly until unmuted.
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iD Button

The iD button provides extra functionality in
the form of an assignable function button, or
it can be used to activate iD14’s ScrollControl
which turns the encoder into a virtual scroll
wheel allowing you to control compatible

parameters within your DAW or plugins.

When the iD button is set as a function button,
the encoder will continue to control the output
that was previously selected. The iD button is

assigned in the iD app.

Hardware Metering

The 8-segment hardware meters indicate
playback level of the iD mixer app, so it is
suggested that end users observe their DAW

metering for input levels.

Status LED

The status LED indicates connection via
USB to your computer. A solidly lit light means
that there is stable communication between

iD14 and your computer.

19

Kensington Lock

For those who work in educational

establishments or in situations where your
equipment is public facing and subject
to possible theft opportunities, we have
provideda Kensington lock hole to enable you

to protect your iD14.




iD Mixel" App Input Channels - Channel Types

The iD mixer application features three types Using these three channel types, you can
of input channels: build up your main monitor mix and up to
two additional cue mixes.
e Mic Inputs
These are the inputs where you will see Its important to note that the iD mixer
the signal from the iD14’s two analogue application only controls the monitoring
inputs. of the iD14. Changes made to the iD mixer

application won’t affect the level present in

Digital Inputs your DAW or audio software.

These are the inputs from the iD’s optical
inputs. The number of digital inputs
present on the iD mixer application
depends on the digital input type (S/
PDIF or ADAT) and the sample rate being

used.

Daw Returns

These are the signals being played back
from your DAW. The iD14 has 6 Daw
Return Channels allowing you set up
multiple cue mixes or sends to hardware

outboard gear.




Channel
Name

Meters
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Phase Flip

Pan Control

Stereo
Grouping

Mute

Fader

Channel Features

Channel Name

By double clicking on the name of the channel
you can rename it fo help you organise youriD
mixer application. You could name a channel

‘Kick’ or ‘Snare’ for example.

Phase Flip

Inverts the polarity of the signal by 180° to
stop phase cancellation. This is useful if you
are micing the rear of a guitar amplifier or the

underside of a snare drum.

Pan Control
Allows you to send the audio fo the left, fo
the right or anywhere between on your Main

Monitor Mix or Cue Mixes.

Stereo Grouping

Allows you fo group two ajacent channels
together intfo a stereo channel with a single
fader controlling the level of both channels.
When a channel is stereo grouped, the pans
will automatically be set to far left and far

right.

+10dB Boost
Selecting this will boost the incoming signal
by +10dB for recording quiet sources. This will

also affect the audio being fed into your DAW.

23

Solo
The Solo button mutes all other channels
other than the one that is currently solo’d.

Multiple channels can be solo’d at one time.

Mute

The Mute button stops this channel from

outputting audio whilst it is engaged.

Fader

The fader controls the amount of signal that is
sent to currently selected mix. This can be set

to anywhere between -inf dB to +6dB.

Meter

The meter shows the current signal level in
dBFS. Should the signal level exceed 0dBFS
then the peak indicators will illuminate red to
indicate a peak. The peak indicators can be
turned off by clicking in them. You can also

turn off all peak indicators using Alt + Click.



Master Section Features

Mix Solo

Mix Selection

................................... . Channel Views

Cue Mix Name

Cue Mix Level

Mix Meters

Chronometer

TR Monitor Controls
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Mix Selection

Clicking on one of mixes allows you to make
changes to that mix. When a mix is selected, it
expands to reveal additional controls for that

mix.

Cue Mix Name

Double clicking on a Cue Mixes name allows
you to rename the Cue Mix. If for example you
were creating mixes for four separate band
members, you could name them ‘Drummer,

‘Guitarist’, ‘Bassist’... efc.

Mix Solo

The Solo button allows you to audition each

of the Cue mixes through your monitors.

Mix level
The Mix level allows you to control the overall

level of the Cue mix that is sent to the outputs.

Mix Meters

The Mix meters show the master signal level

of the selected mix.

Chronometer
The Chronometer allows you to see not only
the current signal level but also the signal

level from a few seconds previously.

This can be great to track down a sudden
loud transient on a particular cue mix or to
monitor the change in level over time as you

make changes to a mix.

25

Channel Views

These three buttons allow you control which
of the three channel types are shown in the
mixer. If for example you weren’t using the
digital inputs for a particular project, you can
simply hide the opftical channels by clicking
on the OPT control.



Monitor Controls
These six buttons control various aspects of
the iD14’s monitor controller capability. The

function of each control can be found below:

e TB (Talkback)
The talkback button switches talkback
on and off. More information regarding
talkback and its various settings can be
found in the ‘System Panel’ section of this

manual.

e @ (Phase Flip)
Pressing this switch flips the phase of
one side of the stereo field. Used in
conjunction with the mono button, this
can be a great way to remove centred
elements from a mix in order to hear the

hidden elements of a mix.

e Mono
The mono butfton sums the stereo outputs
down to mono. This can be used to
quickly check the mono compatibility of
your mix to make sure it’ll sound great

almost anywhere!

e Alt

Alt allows you to quickly switch your
monitor path to a secondary set of
monitors to let you check how your mix

translates on various speakers.

You can select which outputs the ‘ALT’
monitor control flips to in the System

Panel.
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e Dim
Reduces the output level by a preset
amount which can be great if you get a
call or need to quickly chat to someone

during a session.

a([l] dind

Monitor and Headphone Mute

This allows you to mute either the monitor
outputs or the Headphone outputs from the
software. A cross will show through the icon

to indicate that an output is muted.

System Panel Features

oo
DIGITAL IN

Digital Input
Format e

PREFERRED

CLOCK SOURCE ANALOGUE

SYSTEM PANEL

ROUTING

Clock Source OUTPUTS

Selection
MONO MODE

Mono Mode

iD MODE

ScrollControl

TRIM

Dim Level

Alt Speaker
Level

Talkback
Source

ROUTING

TALKBACK

DIGITAL IN

PREFERRED
CLOCK SOURCE

MONO MODE SOLRCE

|0 MODE

ScraliContral

TRIH EXTERNAL SOURCE AUDIO SETTINGS

t DEVICE

Buitt-In Microphone

Talkback
Device

MAIN MIX

LN
DIGITAL IN

PREFERRED
CLOCK SOURCE

MONO MODE

iD MODE

Serollfontrol

c

TRIM
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CUEA CUEB DAW THRU

Input
Source

ROUTING

TALKBACK

INPUT SOURCE
None .

Selection



Digital Input Format

Allows you to select whether the optical input
uses ADAT or S/PDIF digital format.

Prefered Clock Source

The Clock source can be selected from either
the internal clock or the optical input. More
information about choosing a clock source
can be found in the clocking section of this

manual.

When using an external clock source the
indicator beside the selector shows the

current status of the clock on that input.

e Red - No clock signal detected on input

e Amber - A clock signal is detected but at a
different sample rate to iD14

e Green - A clock signal is detfected

and is at the correct sample rate.

For an external clock source to be working
correctly you would want the indicator to
be green. If the indicator isn’t green, iD14
will default back to the internal clock until it

detects a valid clock input.
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Mono Mode

When the iD14’s Mono feature is engaged
this option controls whether the mono signal

is sent to the left, right or both monitors.
Dim Level

When the iD14’s dim function is engaged,
this control defines how much the level is

reduced by.
Alt Speaker Level

This control defines the level drop/boost
when the iD14 is switched to ALT speaker
mode. This is used to balance levels between

different speaker brands.

Output Routing Selection
Opens the routing matrix for either the
Analogue Outputs, Digital Output 1 or the
Talkback channel.

iD Mode

Controls wheter the iD button engaged Scroll

Control or one of the Monitoring functions.

Routing Matrix

The Routing Matrix allows you to control the
audio source for each of the iD14’s outputs

from the following options:

« Main Mix - This takes signal from the

Master Mix of the iD mixer. This is what is

usually used for most standard playback.

« Alt - This takes signal from the Master
Mix but only when the Alt speaker mode.

is active.

o Cue A & B - This takes signal from the
two cue mixes which can be created
using the iD mixer. Please note that the
hardware volume control does not affect
these mixes and the Cue’s have separate
trims which can be adjusted when the
cue mix is selected in the Main Mixer
Window.

ANALOGUE
OUTPUTS

MAIN MIX CUEA CUEBE  DAW THRU
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DAW THRU - This allows you to route to
outputs exactly as they would appear

in your DAW. For example, if you set
Analogue out 1+2 to DAW THRU, anything
your DAW sends out to Outputs 1+2 will be

sent directly to Analogue outputs 1+2.

Please note that in DAW THRU, the
channel in question will bypass any
volume control and audio will be passed
at full scale. If this output is sent to a set
of monitors without inline attenuation, this

may be very loud.

The only exception to this is the
headphone outputs where the volume

control will still function.



Talkback Source

The Talkback source allows the talkback input
to be taken from one of the iD14’s internal
inputs or from a device connected to the host
computer (such as a built-in microphone or

USB microphone).

When you select an input as your Talkback
channel, the channel for this channel in the iD
mixer will be changed to a talkback channel

which will have a TB button in the centre.

If using an external device, the talkback signal

will appear on channel DAW 6.

Faders will only appear for these channels on

the Cue mixes, not on the Main Mix.

Talkback Device

If an external device is selected then this allows

you to select which connected device is used.
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Saving & Loading Mixer Presets

To allow you to quickly setup your iD mixer
during a session you can save and quickly

load various presets. This is great if you are
moving between recording scenarios quite

often.

Mixer presets can be saved and loaded in

two ways:

« Using the File menu and selecting either

Save or Open.

« Using standard keyboard shortcuts :

Save: Mac - Cmd+S
Windows - Ctrl + S
Load: Mac - Cmd+ O

Windows - Citrl+ O

Saving a Preset

To save a preset, simply setup your mixer the
way that you'd like to save. Then select File >
Save as explained above. The mixer window

should then show the Save dialog.

iD
SAUElMIXER
CONFIGURATION

Drum Hix
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Simply enter the name of your preset and

ppress save.

It is also possible to export your preset files
in order to send them to friends or to simply
save them within your DAW session files for
easy recall later on. To do this, select Export
Mixer Configuration at the base of the Save

screen.
Loading a Mixer Configuration

To load a previously saved preset, select

File > Open to bring up the Load screen.

iD
LOAD MIXER
CONFIGURATION

The previosuly saved configuration will
appear in a list. Select the configration you

wish to use and click Load.

You can also open a mixer configuration

directly from a file by selecting Load From File.



Menu/Task Bar Icons

MacOS

On MacOS, the iD icon appears in the
menu bar in the top right hand corner of the
screen. This gives you quick access to various

functions of the iD14.

Show Mixer

About iD
Visit iD Knowledge Base
Register Product

Check for Updates

Set Clock Source

Quit

Quit
Fully closes the iD mixer application.

About iD

Displays information regarding the current

version of the iD mixer application.
Visit iD Knowledge Base

Opens a browser window for the Audient

Helpdesk with helpful articles and FAQ's.
Set Clock Source

Allows you to quickly adjust the clock source

between the internal and optical clocks
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Check for Updates

The iD app will check with the Audient
update server for any available firmware
updates for iD14.

Windows

The Windows taskbar Icon has all the options

of the MacOS menu bar icon but also

includes some Windows Specific options.

| Show Mixer

: Quit

About iD
Vigit iD Knowledge Base
Register Product

Ch far Updates

510 Buffer Size

16:47
A F Qx ENG =]

231172020 2

Set Sample Rate

Sets the operating sample rate of iD14. 44.1,
48, 88.2 and 96kHZ are the four options

available.

Set ASIO Buffer Size

Sets the buffer size of the iD14 between 16
and 4096 samples. Higher sizes will take
processing load off your computer but will

cause increased laftency.

Firmware Update

Occasionally, Audient will release a firmware
update for the iD14 in order to address

bugs, improve compatibility and add new
features. Therefore you may wish to check

occasionally for any updates.

This can be done by navigating to the Window

menu and selecting Check for Updates.

The iD mixer application will then check with
our update server if any updates for the iD14
are currently available. If there are then you

will prompted to install them onto the iD14.

UPDATE FIRMWARE

From audient.com:

@ From file:

13

If you then click next, you’ll be prompted to
stop any playback through the iD14. Click
Update and the update will begin. The iD14

may turn off a number of times.
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Keyboard Shortcuts

Keyboard Shortcut Index

To allow you to find all shortcuts for the mixer

application in one place without having to

go through each page of this manual please

refer to this table:

Location

Faders

Pans

Solos

Meters

System Panel

View Modes

...................................................................................................................
.

.
...................................................................................................................

Mac

Alt + Click
Alt + Click

Cmd + Click

Alt + Click

Cmd+S
Cmd+0O
Cmd +1
Cmd +2
Cmd+3
Cmd + 4

Windows

Alt + Click
Alt + Click

Ctrl + Click

Alt + Click

Ctrl +S
Ctrl+0
Ctrl +1
Ctrl + 2
Ctrl + 3
Ctrl + 4

Description

Resets fader to unity gain (0 dB)
Resets pan pots to central

position

Clears all solos if clicking on a solo'd
channel

Overrides all other solos (for solo
exclusive) if clicking on an unsolo’d
channel

Clicking on peak hold indicator will
clear all clip indicators

Save mixer configuration

Load mixer configuration

View Mic/Line Input

View Optical (Digital) Inputs

View DAW Mix Inputs

View System Panel

Please check the iD14 page online at audient.com/products/iD14

for the latest mixer application updates.

More shortcuts may be added without notification.

Operation with Pro Tools

If using Windows, ensure that you have
followed the installation instructions found on

page 11.

With iD14 connected, launch Pro Tools and
ensure that a new session is created at
the desired sample rate. If you are using
Windows, make sure that you have already
set your Latency and Buffer Size settings in
the iD System Tray before opening a project.
Changing these mid session will result in Pro

Tools needing to restart.

Create Session from Temalate...
) Create Blank Session...

Sussion Parameters.

Audio File Type: Samplo Hate:
B [WAV) & 40 kHz i
O 248it
o]
Playback Engine

Go to Setup > Playback Engine... and ensure
that iD14 is set as the active playback

device.

s Filo Edt View Track Clp Event AudioSuite Options [ERRR0)| Window Marketpiace Haip

Pro Tools Setup
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Playback Engine

Playsack Ergine: | Audiont D14 T
Settings
HW Buffer Size: | 120 Samples hA
Hoet Engino: [ lgrore Erars During Playback/Rocord
imay cause chele and pope)
Minimize Additional U0 Latency
Dyramic: Plugein Procassing
Widoo Engino: Enable
Disk Playhack
szt Sivee: | Noemal bl
Lower values for the disk buffer reduoe memory Usage. Higher values improve digk perfonmance.

Go to Setup > 1/0... to label your inputs and
outputs and ensure that iD14 is correctly
reporting 10-inputs and 6-oufputs to and

from Pro Tools.

" o Vocals (Monc)

Guitar (Mong) !

For more Pro Tools information consult your

Avid user manuals & documentation.
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Operation with Logic Pro

Once iD14 has been successfully installed
following the steps detailed after page 11 of
this manual, launch Logic Pro and check the

following:

Logic Pro > Preferences > Audio

[} (N0 - P 8 File Edit Track MNavigate Record Mix View Wing
About Logic Pro X

Preferences
Control Surfaces
Key Commands » MIDI...
. - Display...
Download Additional Content... s
Provide Logic Pro Feedback T
Download Logic Remote... AtGmaticn.
Learn About MainStage... . Myinfo...
Services » Advanced Tools...
Hide Logic Pro X 3H | Initialize Al Except Key C

Ensure that iD14 is selected as the active

audio device and set the buffer size (to affect
system latency). If you are experiencing issues
with playback stability and CPU loading, fry
increasing the buffer size. This appears with
“overload” errors and/or pops and clicks and

distortion in the audio.

General  Editing O Assignments  Audio File Editor  MP3

< Enabled
ice:  Audient iD14
Audient iD14

12

Automatic
edium

Playback & Live Tracks

Apply Changes
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Logic Pro Setup

If you are using the iD mixer to monitor input
signals while recording, be sure to disable
Logic’s software monitoring fo avoid phasing
as the same source will be heard twice with
a short delay between the low latency DSP
signal and the delayed software monitoring

signal.

Assigning 1/0

All of iD14’s input and output channels will
be available to Logic for routing. There are
a total of 10-inputs and 6-outputs reported
from the driver. You can rename input and
output channels to whatever you wish using
the 1/0 label function. This is a great way to

keep things organised.

v Inputi |

No Input

- Input v Input1

= Bus Input
St
ut 3

nput 4

Mix > 1/0 Labels

[ ——
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Operation with Logic Pro

If you are using an external clock source

(ADAT or S/PDIF) to clock iD14, please ensure
that your Logic Pro project is set o the same
sample rate when recording and playingback
in a session, otherwise things may sound a bit

sharp or flat!

File > Project Settings > Audio

Logic Pro X W3I“W Edit Track MNavigate Record Mix WView Windo
New {H3EN
New from Template... #EN
Open
Open

Close
Close Project NEW
Save #S
Save As... HES
Save A Copy As...

Save as Template...

Recent

Project Settings

Page Setup..
Print

Movie

Export
Bounce

If you are using the internal clock in iD14,
sefting the sample rate via Logic Pro will
update the iD14 sample rate to follow your

session.

There may be a slight pause as the system

re-clocks. This is normal.

This can be verified in Audio MIDI Setup.
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Macintosh HD > Applications > Utilities

Audio Devices

Audient iD14

Clock source: | Audient Internal Clock =

!@! Output |

Source: Default

Format: [44100.0 Hz | v | 10ch-24bit Integer
=

Ch | Volume Value  dE

L Ao BRI e =

=
1
1
1
|
I
I
|
|
1
1
|
1
I
1
|
1
1
|
1
|
|
1
|
|
|
1
1
|
1

For more Logic Pro information please
consult your Apple user manuals &

documentation.



Operation with Cubase / Nuendo

If using Windows, ensure that you have
followed the installation instructions found
on page 11. With the iD14 plugged into your
computer, Launch Cubase or Nuendo and

once a session is open, go fo:
Studio > Studio Setup...

Studio Window Hub Help
Audio Connections...

MixConsole
MixConsole in Project Window

VST Plug-in Manager
Audio Performance...
Video Player
On-Screen Keyboard...

More Options
ReWire

Studio Setup...

Select VST Audio System from the list of options

Devices

Bl Chord Pads
Chord Pads
= MiDI
MIDI Port Setup
BB Remote Devices
Track Quick Controls

BB Transport
Record Time Max
B Video
= Video Player
VST Audio System
Audient iD14
VST System Link

o Cubase/Nuendo Setup

Then select the Audient iD14 from the
dropdown menu. You will be asked if this is

okay, select “Switch”.

No Driver

Close the VST device setup panel and navigate

to the Audio connections panel:

Devices > Audio Connections (F4)

Here you can ensure that all buses have been
created in Cubase / Nuendo and therefore
all ports are addressable in your session. Add
new buses and assign them fo the necessary
I/0O if required.

If using the iD14 Mixer App to monitor your
inputs, ensure that input monitoring is turned

off on the track.

+ &
[T Input/Output Channels

Operation with Ableton Live

If using Windows, ensure that you have
followed the installation instructions found on

page 11.

With iD14 plugged into your computer, launch
Ableton Live and head straight to:

Live > Preferences > Audio

_ﬂ'm File Edit Create View Options Help

@ O About Live

Preferences...

Services

Hide Live
Hide Others " 3H
Show All

Quit Live #Q

Here navigate to the Audio tab and make sure

that iD14 is assigned as the playback device.

Preferancas

In the Live Audio Preference panel you can
set an appropriate buffer size (this can be

kept high if you are monitoring input signals

for recording via the iD mixer. Ensure that

iD14 reports as a 10-in, 4-out device to Live.

Ableton Live Setup

If necessary you can limit the number of /o
channels reported as active inputs (from the
driver) in Live by using the input and output
config tabs. This is an excellent feature to
help reduce CPU loading if all channels are

not required.

9 Preferences

Input Config




Troubleshooting & FAQ

Troubleshooting
“The unit will not power on”

Double check that the USB cable is plugged
in. If it still won’t power on, try using a different
USB port on the computer and possibly even
a different USB cable. If you are using a USB
hub, please try plugging iD14 directly into the

computer.

“I get clicks and pops on DAW
playback”

This is most likely fo do with setting the

buffer size too low for your computer. This
can be caused by running very large projects
with a lot of plugins and virtual instruments.
Experiment with higher buffer sizes. Typically
you want small buffer sizes for tracking or
recording software synths to keep the latency
low. However when mixing it is fine to set a
slightly higher buffer size as latency is not so

much of a problem.

“When | connect to my computer,
| cannot play any audio out from iD14”

Firstly double check that the USB cable
connecting iD14 to your computer is

functional and attached at both ends.

Double check that iD14 is set as the active

playback device in your DAW and computer:

System Preferences > Sound >
Output Tab > Audient iD14 (macOs)

Control Panel > Hardware and Sound >
Sound > Manage Audio Devices > Audient
iD14 (Windows)

Launch the iD mixer application to activate
communication between your computer
and iD14. This only needs to be done once
straight after power up. Once iD14 is set to the
operational state you desire, you can quit the
iD application and it will continue to function

as intfended.

In the software mixer, locate the DAW
channels by pressing the DAW view button
and increase the level of DAW 1+2 fader.

ann Sound
-~ Show All Q

Sound Effects [T

Select a device for sound outpur

Name Tree
Internal Speakers. Built-in
Avid Coreudio Device

Pra Tools Aggregate |10 Agaregate device
Audient D14 use
Settings for the selected device:
The selected device has no output controls
7
Output voluma: o 1!)) Mt

™ Shaw volume in menu bar

Troubleshooting

“I have clocking issues which include
iD14 not locking to external ADAT or
SPDIF devices or operating at the
incorrect rate compared to my session”

If there is an issue with syncing of an external
device, the Status LED in the System Panel
will be red or yellow. If the status light is red
then iD14 cannot detect a clock signal from an
external device, and yellow if it can defect a

signal at the wrong sample rate.

To change sample rate in OSX go to Audio MIDI
Setup found by navigating to the folder:

Macintosh HD > Applications > Utilities > Audio
MIDI Setup

Ensure that Audient iD14 is seen as an audio
device (Window Menu > Show Audio Window).

RSN Audio Devices
% Built-in Microphane
2in/ 0 out 1) Audient iD14
% Built-in Input Clock source: | Audient Internal Clg

Source: Default

Avid CoreAudin Device

Format: |44100.0 Hz | v | 10ch-

o Pro Tools Aggregate |/O Ch | Volume
r Lin/ 2 out

[1osin kUM e

Double check that an appropriate clock
source is selected (Internal for master
operation), ADAT or S/PDIF clock for
external slave operation. Ensure that you
see the correct sample rate displayed in

the Format drop-down menu.

Audio Devices

Audient iD14

Clock source + Audient Internal Clock ’
Audient S/PDIF Clock
Audient ADAT Clock

Source: Default

Format: 44100.0 Hz g 10ch-24bit Integer

If you are using Windows, go to the iD
icon in the system tray and right click on it.
This will bring up some settings including
sample rate. Alternatively you can alter

these settings in the Setup tab of the iD
app.

Change the sample rate to match that of

the external ADAT device and session.

Show Mixar
Quil

About iD
Visit 10 Knowledge Base
Register Product

Check for Updatea

Sat ASIO Buffar Size
Set Sample Rate

Sat Clock Source
O

A = fx ENG

16:47
23/11/2020 %



Troubleshooting

“HowdolresettheiD mixerapplication
to its default state?”

To reset the mixer application, quit the
iD app completely, then navigate to the
following folder and delete the state.xml file
(it will replenish upon a fresh launch of the

application)

Macintosh HD > User > Library > Application

Support > Audient > iD > state.xml

(C:) > Users > yourusername > AppData >

Roaming > Audient > iD > state.xml

Do not delete the parent folder as this will

also contain your iD mixer presets.

“How do | make sure | have the latest
version of iD firmware/software?”

To check for the latest updates to the
iD desktop mixer application please visit:

audient.com/products/id14/down-

loads and download and install the latest

driver.

You will be made aware of firmware releases
from the iD app when connected to the
internet. Please refer to page 13 in

this user manual for more information

regarding firmware update.
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FAQs

For more information and bug support,
please search our online Help Centre which

can be found here:

support.audient.com

For technical support please create
a ticket in our online support system,
which can also be foundin the support section

of our website (see link above).

Technical Specifications

D.l / Instrument Input:

RANGE:

LINEUP:

MAX LINEUP:

THD+N @ 0dBu:

SNR:

FREQUENCY RESPONSE - MIN GAIN

174" TS JACK:

40dB
12dBu = 0dBFS

+10dBu

0%

100dBu A-Weighted
+0.5dB 10Hz to 20kHz

Tip (Hot) & Sleeve (Shield)

Analogue to Digital Converter:

THD+N @ -1dBFS:
DYNAMIC RANGE:
CMRR:

FREQUENCY RESPONSE:

Digital Input:

8-CHANNEL ADAT:
4-CHANNEL ADAT:
STEREO S/PDIF / TOSLINK:

Headphone Outputs:

(Measurements with 100k load)

LINEUP:

THD+N @ -1dBFS:
DYNAMIC RANGE:
CROSSTALK: >116dB
FREQUENCY RESPONSE:
MAXIMUM LEVEL @ 30R:
MAXIMUM LEVEL @ 62R:
MAXIMUM LEVEL @ 600R:

0.0009%

1/4" TRS JACK::

0.001%

120dB A-Weighted
>80dB

+0.5dB 10Hz to 40kHz

4471kHz to 48.0kHz
88.2kHz to 96.0kHz  SMUX
441kHz to 96.0kHz  (Stereo)

18.5dBu = 0dBFS

125.5dB A-Weighted

+0.25dB 10Hz to 40kHz

2.59V Peak, 1.827V RMS, 223rmw
418V Peak, 2.95V RMS, 280mw

7.72V Peak, 5.46V RMS, 100mW

Tip (Left), Ring (Right) & Sleeve (Shield)
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Microphone/Line Input:

GAIN RANGE:

LINEUP:

MIC MAX INPUT LEVEL:
MAX INPUT LEVEL:

INPUT IMPEDANCE (Mic):
INPUT IMPEDANCE (Line):
THD+N @ 0dBu

SNR:

EIN:

CMRR @ 1k:

CROSSTALK:

FREQUENCY RESPONSE - MIN GAIN

XLR COMBI FEMALE:

58dB

12dBu = OdBFS
12dBu

21dBu

2.8k

>8k

0.00170%

101dBu A-Weighted
-129dB A-Weighted
>-75dB

>-100dB

+0.5dB 10Hz to 40kHz

Pin 2 (Hot), Pin 3 (Cold) &
Pin 1 (Shield)

174" TRS JACK: Tip (Hot), Ring (Cold) &
Sleeve (Shield)

Line Outputs (DAC):

LINEUP: 12dBu = 0dBFS

THD+N @ -1dBFS: 0.0006%

DYNAMIC RANGE: 125.5dB A-Weighted

CROSSTALK: >120dB

FREQUENCY RESPONSE:

+0.1dB 10Hz to 40kHz

1/4" TRS JACK:: Tip (Left), Ring (Right) & Sleeve (Shield)

USB-C High Speed:

BUS POWER:

MIN REQUIREMENT: 0.9A @ 5V >=USB 3.0 Port

MAX REQUIREMENT: 1.5A @ 5V USB-C: Provides higher
headphone outputs levels

No. of INPUT CHANNELS: 2 (2 Analogue)

No. of OUTPUT CHANNELS: 2 (2 Analogue)

DSP MIXER LATENCY:

ROUND TRIP (in-to-out)
44kHz  0.65mS

48 0kHz 0.6mS
88.2kHz  0.33mS
96.0kHz  0.31mS


https://support.audient.com/hc/en-us
http://audient.com/products/id14/downloads
http://audient.com/products/id14/downloads

Dimensions

h

173mm

y

AUDIENT

wwozl

wwi'zo

OPTICAL
INPUT

AUDIENT

4R OUT 3L

2R OUT 1L
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2 MIC/LINE 1

wwoy

wuwl'L9

Warranty

Warranty Statement

Your iD14 comes with a manufacturer’s warranty for one year (12 months) from the

date of despatch to the end user.

The warranty covers faults due to defective materials used in manufacture and faulty

workmanship only.

During the warranty period Audient will repair at its discretion or replace the faulty unit
provided it is returned carriage paid fo an authorised Audient service centre. We will not
provide warranty repair if in our opinion the fault has resulted from unauthorised modification,

misuse, negligence or accident.

We accept liability to repair or replace your iD14 as described above. We do not accept
any additional liability. This warranty does not affect any legal rights you may have against

the person who supplied this product - it is additional to those rights.
Warranty Limitations

This warranty does not cover damage resulting from accident or misuse. The warranty is void
unless repairs are carried out by an authorised service centre. The warranty is void if the unit
has been modified other than at the manufacturer’s instruction. The warranty does not cover
components which have a limited life, and which are expected to be periodically replaced for
optimal performance. We do not warrant that the unit shall operate in any other way than as

described in this manual.

...................................................................................................................

Audient Ltd

Aspect House

Herriard

Hampshire

RG25 2PN Tel: +44 (0) 1256 381944

United Kingdom audient.com

...................................................................................................................
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Service ~ Glossary

Service Information A Amperes
: ADAT Alesis Digital Audio Tape
iD14 contains no user-serviceable components, please refer to qualified service personnel ADC Analogue to Digital Converter
for diagnosis and repair. Your warranty will be void if you tamper with the device at component DAW Digital Audio Workstfation
level. If you have any questions with regard to the repair, please contact Audient Ltd. ASP Analogue Signal Processing
CPU Central Processing Unit
CUE Artist Headphone Mix
If your unit is in warranty, please contact your dealer directly for a repair or replacement (at the : DAC Digital fo Analogue Converter
discretion of the dealer). : dB Decibel
: dBu Decibel referenced to 0.775Vrms = 0 dBu
For out of warranty repairs, please contact Audient Ltd, after which a Return Materials dBFS Decibel Full Scale
Authorization (RMA) number will be assigned. This number will serve as a reference for you DC Direct Current
and helps facilitate and expedite the return process. When the unit is returned please include this D.I Direct Injection (Instrument Input)
RMA number along with a description of the fault inside the packaging box. DoC Declaration of Conformity
: DSP Digital Signal Processing
To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or make EQ Equaliser
an enquiry, please visit: support.audient.com FAQ Frequently Asked Questions
FCC Federal Communications Commission
GB Gigabyte
GUI Graphical User Interface
HPF High Pass Filter
HV High Voltage
i/o Input / Output
JFET Junction Field Effect Transistor
LED Light Emitting Diode
RoHS Restriction of Hazardous Substances
RAM Random Access Memory
S/PDIF Sony Philips Digital Interface Format
THD+N Total Harmonic Distortion + Noise
TRS Tip Ring Sleeve (1/4” Jack Balanced)
TS Tip Sleeve (174" Jack Unbalanced)
USB Universal Serial Bus
Vv Volts
XLR Extra Live Return, Extremely Low Resistance, Canon X Series, Latching,

Resilient Rubber Compound... or make up your own!

...................................................................................................................

46 47


https://support.audient.com/hc/en-us

	Button 2: 
	Button 3: 
	Button 5: 
	Button 6: 


